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Introducción_________________________________________________________ 
 
La asignatura Estructura de Computadores II, en su apartado teórico, presenta una gran heterogeneidad de 
temas, tal diversidad no puede llegar a plantearse en el laboratorio y por ello nos centraremos en uno de los 
temas para hacer especial hincapié en aspectos que, el alumno de Informática Técnica de Gestión, no volverá 
a encontrar en el resto de asignaturas. Este tema es el relacionado con el Lenguaje Ensamblador y el 
Ensamblador. 
 
Las asignaturas EC I y EC II son las únicas que acercan al alumno a aspectos relacionados con el lenguaje 
próximo a la máquina (lenguajes de bajo nivel). Consideramos que es de gran importancia que el alumno 
perciba y “visualice” como se mueve la información a nivel del Procesador, Memorias y Periféricos ya que, 
cuando estos procesos se realizan en lenguajes de alto nivel, queda borroso como se realiza el flujo de datos 
e instrucciones. 
 
La asignatura EC I realiza este acercamiento a nivel de Laboratorio y la asignatura EC II lo realiza a través 
del tema LENGUAJE MÁQUINA Y ENSAMBLADOR y de diversos ejercicios planteados en el 
Laboratorio. 
 
Los ejercicios se plantean con una dificultad gradual, acercándonos a instrucciones que nos permitan conocer 
y manejar mejor la arquitectura del procesador. Este acercamiento gradual permite acometer un último 
ejercicio de una cierta complejidad funcionalidad. 
 
Para el desarrollo de esta actividad nos apoyaremos en una herramienta de desarrollo software de amplia 
implantación industrial como es el entorno de desarrollo Keil. Este entorno de desarrollo está disponible en 
el servidor del departamento en su versión libre de estudiante. 
 
La primera sesión, y como clase magistral,  consistirá en una introducción al entorno de desarrollo Keil, para 
a continuación, describir la arquitectura del microcontrolador escogido para las prácticas.  
 
Las sesiones posteriores serán en Laboratorio, donde continuaremos con el desarrollo de los cinco ejercicios 
propuestos. Al final de las sesiones dedicadas a la realización de los ejercicios, se dedicarán dos sesiones de 
laboratorio a evaluar el trabajo realizado durante el curso. 
 
Dado el número de alumnos matriculados en esta asignatura, se realizarán tres grandes grupos (1-2-3) y estos 
se subdividirán en 10 subgrupos (1-..-10) formados por dos o tres personas. Las sesiones en el Laboratorio se 
plantearán por rotación de grupos (1→2→3→1...) de 1h30’ de duración. En cada puesto de trabajo (PC) se 
ubicará un subgrupo de manera fija. Teniendo en cuenta que el Laboratorio presenta una duración de tres 
horas, en cada jornada entrarán dos grupos, uno primero y otro al finalizar la sesión del anterior. 
 
La bibliografía recomendada es la siguiente:  

 M. Barrón, J. Martínez. “Aplicaciones prácticas con el µC-8051”. Ed. M. Barron - McGraw-Hill. 1999. 
 
En este cuaderno se suministra el material de consulta necesario para la realización de las prácticas que se 
completará con las anotaciones del alumno. Este material ha sido extraído de la referencia anteriormente 
citada. Además se citan páginas de Philips y Keil donde podrá el alumno encontrar este material en inglés. 
 
Como apunte final precisaremos que este cuaderno no substituye a las explicaciones, comentarios, matices 
aportados por el profesor en todas y cada una de las sesiones de Laboratorio. Es labor del alumno el 
completar esta documentación con toda suerte de comentarios y aclaraciones. 
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Guía de Prácticas EC II________________________________________________ 
 

1. INTRODUCCIÓN AL ENTORNO DE DESARROLLO KEIL 
a. Programa en el servidor del departamento en la escuela (http//det.bp.ehu.es ), en Programas, 

Laboratorio EC2 
b. Crear CD 
c. Creación de un Proyecto 
 

2. INTRODUCCIÓN AL MICROCONTROLADOR 80C552 
a. Bibliografía básica. Libro de biblioteca 
b. Estructura interna 
 

3. REPERTORIO DE INSTRUCCIONES DEL µC80C552 
a. Copia del repertorio en este cuaderno 
 

4. RELACIÓN DE EJERCICIOS 
a. Ejercicio Nº 1: 

• Creación de un proyecto concreto 
• Ejemplo de programa 
• Ejecución 

b. Ejercicio Nº 2: 
• Mapa de memoria de la RAM interna 
• Acceso Directo e Indirecto (Bancos BK0 – BK3) a la RAM interna 
• Ejercicio 2: Suma de dos valores en RAM 

 Almacenamiento de dos valores en la RAM interna alta 
 Sumar los dos valores y dejar el resultado en la RAM baja 
 Llevar el resultado a la RAM alta 

c. Ejercicio Nº 3: 
• Registros PSW - DPTR 
• Actuación sobre bits – Actuación sobre bits del acumulador A 
• Acceso a puertos P1[], P4[] y P5[] 
• Ejercicio 3.1: Mover bits 

 Mover bits de un área de memoria (20H – 2FH) 
• Ejercicio 3.2: Actuar sobre bits de P1 

 Actuar sobre bits de P1 y leer su estado 
• Ejercicio 3.3: Trabajar con R0 de todos los bancos (amplía el ejercicio 2) 

 R0 de BK0, R0 de BK1, R0 de BK2 y R0 de BK3 
 Cargar direcciones (80H .. 83H) y diferentes valores en las direcciones  

d. Ejercicio Nº 4: 
• Ejercicio 4.1: Rotación de bits (mover bits) 

 Cambiar 55H por AAH con dos instrucciones, utilizándolas cuantas veces sea necesario. 
• Ejercicio 4.2: Trabajo con cuatro bancos (amplía el ejercicio 3.3) 

 Trabajar con cuatro áreas de memoria (A, B, C, D) estando su dirección de origen 
almacenada en el registro R0 de los bancos BK0, BK1, BK2 y BK3. Sumar A+B, dejando 
el resultado en C. Dividir por 2 el resultado y dejarlo en D. 

e. Ejercicio Nº 5: 
• Tratamiento de las subrutinas (LCALL - ACALL) 
• Ejercicio 5.1: Tratamiento simple de LCALL 

 Realizar una operación de una llamada a subrutina 
• Ejercicio 5.2: Tratamiento complejo de LCALL 

 Control de nivel de un depósito de agua 
 

5. EVALUACIÓN DE TRABAJOS 
 Se dedicarán dos sesiones de laboratorio a evaluar el trabajo realizado durante el curso. 
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Introducción al Entorno de Desarrollo Keil________________________________ 
 
1. Lanzamiento del Programa 
 Se pincha dos veces el icono “Keil uVision”, en este momento se lanza el entorno de desarrollo. 
 
2. Creación de un nuevo proyecto 

a. Sobre el Menú de la barra superior: Project  → New Project 
b. En la opción “Guardar en:”  buscar en “c:” la carpeta “Mis Documentos” 
c. Crear la carpeta “Laboratorio_EC_II” 
d. Dentro de la anterior carpeta, crear la carpeta “Grupo_x” (1,2 o 3) 
e. Nombre del proyecto, p.ej., “Ejercicio_1” con la extensión “uv2” 
f. Validar 

   
3. Selección de Microprocesador 

a. Al validar el nombre del proyecto, nos aparecerá una ventana de selección de microprocesador. 
Seleccionar “+Philips” 

b. Pinchar el símbolo “+” y de la lista de micros seleccionar “80C552”. Leer la leyenda que aparece a la 
derecha del microcontrolador escogido. 

c. Validar 
 

4. Opciones del Proyecto 
a. Observamos que se ha creado una carpeta denominada “Tarjet 1” 
b. Situamos el ratón sobre esta carpeta y pulsamos el botón derecho del ratón (también podemos ir al 

menú “Project” → “Options” ........) 
c. Se despliega un menú “Options for Tarject ‘Tarject 1’” 

- Tarject: Dejar sin modificar 
- Output: “Select Folder for Objects” : “Grupo_x” 
- Listing: Idem 
- Debug: Aparecen dos pantallas 
 Pantalla izquierda Pantalla derecha 
 ◙ Use Simulator ◘ Use Keil Monitor 
   botón “Settings” 

- COM1 
- 19200 baudios 

 
5. Crear Programa Fuente 

a. Hay que crear y añadir un fichero al “Tarjet 1” 
b. Nos situamos en el menú superior “File” → “New” → “Text1”: → opción “Save As” lo 

renombramos, p.ej. “ejercicio_1.asm” (se incorpora la extensión “asm” de ensamblador)  
c. □ Tarjet1 

  |-- □ Source Group 1  
d. Posicionamos el ratón sobre esta última carpeta y pulsamos el botón derecho 
e. Escogemos la opción “Add Files to Group .....” 
f. Aparece una pantalla en la que escogeremos las extensiones “Asm Source Files (*.a*)”, que son las de 

lenguaje ensamblador 
g. Con la opción “Add” añadimos “ejercicio_1.asm” 
 

6. Escritura del Programa 
a. Se escribirá el programa en el ensamblador del 8051 
b. Comienzo ORG 0x00 
 ········ 
 ········ 
 END 
c. Se escribirá tabulado 

 ETIQUETA: CÓDIGO OPERANDOS ;COMENTARIOS 
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7. Ensamblado/Compilación del Programa 
a. Nos situamos en el menú superior “Project” → “Build Tarject” 
b. Se realiza el ensamblado (compilación si fuera alto nivel) y nos fijaremos en la ventana inferior donde 

se obtiene un resumen de los errores y avisos del ensamblado 
c. Por rapidez este proceso puede lanzarse pinchando el icono relativo a “Build Tarject” ubicado en las 

líneas de iconos del Keil 
 

8. Depuración del Programa 
a. Nos podemos situar sobre el menú “Debug” → “Start/Stop ...” pero lo realizaremos con los iconos 
b. Pinchamos el icono lupa”d” (símbolo rojo con una “d” en su interior) 
c. Aparece una pantalla con registros 

- r0 ... r7 
- a, b, ... 
- etc... 

 Estos son los registros del 80552 
d. Ejecutamos el programa pinchando el icono que tiene una flecha entre llaves “{↓}” su función es 

ejecutar el programa “paso a paso” (“step” o “step into”) 
 Vemos en el programa el desplazamiento de “barras de color” indicando la posición actual 
 Una flecha amarilla nos indica el comienzo del programa 
 Al ir ejecutándose las instrucciones, los registros afectados se resaltan en azul 
 Aparece una pantalla “Dissasembly” que es el programa desensamblado. Como trabajamos en 
Lenguaje Ensamblador, el código es el conocido (en C se correspondería con el desensamblado de 
las instrucciones de alto nivel) 

 Es interesante disponer del mapa de memoria RAM cuando le afectan determinadas operaciones. 
Nos situamos en el menú “View” → “Memory Window” , si la ventana aparece en blanco, 
introduciremos una dirección, p.ej. D: 0x00 <┘ 
Hay que escribir “D:” para indicar que estamos en Memoria de Datos 

 
9. Ejemplo Sencillo 
 Veamos el siguiente programa 
 
  ORG 0x00 ; Origen. Dirección en Hexadecimal 
  SJMP INICIO ; Salto corto 
  ORG 0x20 ; Dirección de comienzo del programa 
    ; Las primeras líneas se dedican a “interrupciones” 
 INICIO: MOV A,#0x10 ; Carga en A el valor inmediato 10H 
  MOV 0x60,A ; Carga el contenido de A (10H) en la dir. 60H 
  MOV B,0x60 ; Carga en B el contenido de la dir. 60H (10H) 
  END  ; Fin del programa para el Ensamblador 
 
 Sobre este ejemplo efectuaremos el Ensamblado y Depuración, observando registros y posiciones de 

memoria. Finalizado el ejercicio salvaremos a disquete el programa. 
 
Notas del Alumno: 
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Ejercicio Nº 1_________________________________________________________ 
 
1. Ejercicio: Llevar a cabo la creación del primer proyecto “Ejercicio_1” siguiendo todos los pasos dados 

en la introducción al entorno de desarrollo. Escribir y depurar el ejercicio propuesto como ejemplo. 
 

Nota: Una vez finalizado el ejercicio, se salvará a disquete el archivo generado. Este recordatorio es 
extensivo al resto de ejercicios y no volverá a ser repetido. 

 
Notas del Alumno: 
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Ejercicio Nº 2_________________________________________________________ 
 
2.1 Aspectos teóricos: 

a. Mostrar Mapas de memoria interna: Acceso Directo – Acceso Indirecto – SFR 
b. Acumulador: Actuación sobre A 

 
2.2 Ejercicio: 

a. Almacenar dos valores (0FH y 11H) en las posiciones de RAM alta 80H y 81H. 
b. Sumar los dos valores y dejar el resultado en la posición de RAM baja 7FH 
c. Llevar el resultado de la posición 7FH a la FFH 

 
Notas del Alumno: 
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Ejercicio Nº 3_________________________________________________________ 
 
3.1  Aspectos teóricos: 

a. Mapas de memoria interna: Acceso Directo – Acceso Indirecto – SFR 
b. Registro PSW: Actuación sobre Bancos de trabajo – Visión en la ventana de depuración 
c. Actuación sobre bits: SETB – CLR. Mapa 20H .. 2FH 
d. Acumulador: Actuación sobre bits de A – Mapa SFR: 0E0H  
e. Acceso a puertos: P1[]: 090H, P4[]: 0C0H, P5[]: 0C4H 
f. Visión de P1 en depuración 
g. Registro DPTR 

 
3.2  Ejercicio: 

a. Mover bits del área de memoria de bits: 
 Poner a 1 el bit 0 de la 20H, etc.. 
b. Actuar sobre bits de la puerta P1 y leer su estado: 
 Mover 00H a P1, P1 a A, FFH a P1, P1 a A, Borrar P1, Mover P1 a A, Poner a 1 el bit 7 de P1, Leer 

la puerta P1, Borrar bit 7 de P1, Mover P1 a  A. 
c. Trabajar con R0 del BK0, R0 del BK1, R0 del BK2, R0 del BK3: 
 Mover 55H a la dirección 80H por medio de R0 del BK0 
 Mover AAH a la dirección 81H por medio de R0 del BK1  
 Mover 1FH a la dirección 82H por medio de R0 del BK02 
 Mover F1H a la dirección 83H por medio de R0 del BK3 
d. Sumar el contenido de la dirección 80H (R0-BK0) con el contenido de 81H (R0-BK1),...., 83H (R0-

BK3), dejando el resultado en la posición 30H. 
 
Notas del Alumno: 
 

 
  
 
 

 



Departamento de Electrónica y Telecomunicaciones    

Ejercicios de Laboratorio de EC II   Ver 1.1  - 9 - 

Ejercicio Nº 4_________________________________________________________ 
 
4.1 Aspectos teóricos: 

a. Mapas de memoria interna: Acceso Directo – Acceso Indirecto – SFR 
b. Registro PSW: Actuación sobre Bancos de trabajo – Visión en la ventana de depuración 
c. Acumulador: Actuación sobre el A 

 
4.2 Ejercicio: 

a. Área A de n bytes y B de n bytes de Datos. Cargarlas por medio de R0 de BK0 y BK1 
respectivamente 

b. Sumar A con B uno a uno todos los valores y dejar el resultado en el área C de n bytes. El área C se 
controla con R0 del BK2. 

c. Dividir los valores del área C por 2 y llevar el resultado al área D de n bytes. El área D se controla 
con R0 del BK3. 

 
Nota 1: Las cuatro áreas están en la posición alta de memoria. 

 
 Nota 2: Los registros R0 y R1 se utilizarán como apuntadores. 
 

Nota 3: El registro R1 guardará la dirección origen y el R0 la dirección incremental  
 

Nota 4: Las áreas A, B, C y D tendrán un tamaño de 4 bytes. El valor del tamaño (4 bytes) se 
guardará en R2 del BK0. 
 
Nota 5: Los valores a cargar en A serán 01H, 02H, 10H y 20H. Los valores de B serán 10H, 20H, 
11H y 22H. 
 
Nota 6: La carga de valores así como la realización de las distintas operaciones, se ejecutarán por 
medio de un bucle. 
 

Notas del Alumno: 
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Ejercicio Nº 5_________________________________________________________ 
 
5.1 Aspectos teóricos: 

5.1 Mapas de memoria interna: Acceso Directo – Acceso Indirecto – SFR 
5.2 Registro PSW: Actuación sobre Bancos de trabajo – Visión en la ventana de depuración 
5.3 Acumulador: Actuación sobre el A 
5.4 Tratamiento de subrutinas: LCALL 
5.5 Instrucciones condicionales de salto orientadas a Bit y a Byte: 

a. JB bit, etiqueta  ;orientado a bit 
b. JBC bit, etiqueta 
c. JNB  bit, etiqueta 
d. DJNZ registro, etiqueta ;orientado a byte 
e. DJNZ dirección, etiqueta 
f. CJNE operando1,operando2,etiqueta 

 
5.2 Ejercicio 5.1: Subrutina que devuelve el complemento de una variable 

5.2.1 De la posición 30H se lee una variable y se calcula su complemento, dejando el valor en el 
registro A. El valor devuelto en A se lleva a la posición 31H. 

5.2.2 En la posición 30H cargar el valor 55H. 
 

5.3 Ejercicio 5.2: Regulación del nivel de agua en un depósito 
5.3.1 Se efectuará una regulación del nivel por medio de dos Detectores de Nivel NB (Nivel Bajo) y 

NA (Nivel Alto) del depósito y dos Electroválvulas EV1 y EV2 la primera de admisión de agua 
al depósito y la segunda de distribución. 

5.3.2 Los Detectores de Nivel NB y NA estarán asociados a las entradas P1.0 y P1.1 respectivamente. 
Las activaciones de las Electroválvulas EV1 y EV2 estarán asociadas a las salidas P1.4 y P1.5 
respectivamente. La detección de las posiciones de las EV1 (PEV1) y EV2 (PEV2) estarán 
asociados a las entradas P1.2 y P1.3 respectivamente. 

5.3.3 Estados: si NB entonces “1” si no “0”, si NA entonces “1” si no “0”, si PEV1 o PEV2 abierta 
“1” si no “0”. 

5.3.4 Acciones: activar (abrir) EV1 o EV2 por “1”, desactivar (cerrar) por “0”. 
5.3.5 Acciones:  

a. Cuando NB entonces activar EV1 y desactivar EV2 
b. Cuando NA entonces desactivar EV2 y activar EV1 
c. Cuando no NB y no NA entonces activar EV1 y EV2 
d. Estudiar casos de error 

 
Nota: El programa se desarrollará con la premisa de que la detección de Nivel y la detección de 

Posición de electroválvulas sean efectuadas por medio de sendas subrutinas. No se admitirán 
otras soluciones. 

 
Notas del Alumno: 
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Apéndice 1 
 

Diagrama de Bloques de un µC 8xC552 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTA 1: Bloque extraído de la bibliografía recomendada. 
NOTA 2: Puede consultarse la siguiente página de Philips donde se encuentra reseñado este diagrama de 
bloques http://www.semiconductors.philips.com/pip/P80C552.html 
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Apéndice 2 
 

Registros de Funciones Especiales SFR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTA 1: Bloque extraído de la bibliografía recomendada. 
NOTA 2: Una documentación completa puede extraerse de la página de Philips siguiente 
http://www.semiconductors.philips.com/acrobat_download/various/8XC552_562OVERVIEW_2.pdf 
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Apéndice 3 
 

Juego de Instrucciones del µC 8051 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTA 1: Bloque extraído de la bibliografía recomendada. 
NOTA 2: El documento original en ingles (p51_pg.pdf) puede ser obtenido de la página de Keil, el 
enlace es http://www.keil.com/dd/docs/datashts/philips/p51_pg.pdf  
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(Paginación respecto al Apéndice) 
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NOTA 1: Exámenes realizados hasta la fecha de publicación. 
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Ordinaria de ENERO 2004) 

LABORATORIO 
 
1. EJERCICIO 1º : 
 Tenemos una ruleta de tres posiciones, estas son la 1, 2 y 3; además tenemos un interruptor con el cual 

indicamos que comienza el juego. 
 
 El programa está a la espera de que se active el interruptor para ver cual es el número que sale, esta señal 

está en la puerta “0” de P1. Cuando se active este interruptor activaremos la salida 7 de P1 y 
comenzaremos el juego. 

 
- Cuando sea un “1” al contenido de la dirección 30H se le suma un “1” y se almacena el resultado en la 

dirección 80H y se activará la salida 4 de P1. 
- Cuando sea un “2” al contenido de la dirección 30H se le suma un “2” y se almacena el resultado en la 

dirección 81H y se activará la salida 5 de P1. 
- Cuando sea un “3” al contenido de la dirección 30H se le suma un “3” y se almacena el resultado en la 

dirección 82H y se activará la salida 6 de P1. 
 

La señal de “1” se leerá de la puerta “0” de P1. 
La señal de “2” se leerá de la puerta “1” de P1. 
La señal de “3” se leerá de la puerta “2” de P1. 

 
Las entradas son activas por nivel “0” y las salidas por nivel “1”. 

 
2. EJERCICIO 2º : 
 Sumar los contenidos de las direcciones 80H, 81H, 82H y 83H, dejando el resultado en la posición 30H. 

Rotar a la izquierda el resultado y sacar el valor obtenido por el puerto P1. 
 
 
NOTA : El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Extraordinaria de JUNIO 2004) 

LABORATORIO 
 

 
1. EJERCICIO 1º : 
 Disponemos de dos pulsadores, estos son el Pulsador 1 y el Pulsador 2; además disponemos de un 

interruptor “Juego” con el cual vamos a indicar al microcontrolador que comienza el juego. 
 
 El programa está a la espera de que se active el interruptor de “Juego”, una vez activo, el programa 

determinará cual es el pulsador que primero se ha activado o si se han activado los dos a la vez, ésta señal 
está en la puerta “2” de P1. Cuando se active este interruptor activaremos la salida 7 de P1, borraremos el 
contenido de las direcciones 30H, 31H y 32H y comenzaremos el juego. 

 
 La reglas son las siguientes : 

- Cuando se pulse el “Pulsador 1” el contenido de la dirección 30H se incrementa en “1” y se almacena 
el resultado en la dirección 80H y se activa la salida 4 de P1. 

- Cuando se pulse el “Pulsador 2” el contenido de la dirección 31H se incrementa en “1”  y se almacena 
el resultado en la dirección 81H y se activa la salida 5 de P1. 

- Cuando se pulsen simultáneamente los “Pulsadores 1 y 2”, el contenido de la dirección 32H se 
incrementa en “1” y se almacena el resultado en la dirección 82H y se activa la salida 6 de P1. 

- Nuevas pulsaciones se tienen en cuenta cuando se han liberado ambos pulsadores. 
 
La señal de “Pulsador 1” se leerá de la puerta “0” de P1. 
La señal de “Pulsador 2” se leerá de la puerta “1” de P1. 
La señal de “Juego” se leerá de la puerta “2” de P1. 

 
Las entradas son activas por nivel “0” y las salidas por nivel “1”. 
Las señales de salida permanecen hasta que se liberan ambos pulsadores o bien se desactiva la señal de 
juego. 
 

2. EJERCICIO 2º : 
 Sumar los contenidos de las direcciones F0H y F1H, dejando el resultado en la posición 20H. Si hay bit 

de Carry, dejarlo en el bit “0” de 21H. 
 
 

NOTA : El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos 
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Ordinaria de ENERO 2005) 

LABORATORIO 
 

 
1. EJERCICIO 1º : 

Se trata de realizar un programa que efectúe una de dos operaciones (multiplicar o dividir) según el estado 
de un interruptor externo al procesador, la operación se habilita según el estado de otro interruptor. Las 
operaciones se realizarán en sendas subrutinas. 
 
Disponemos de un interruptor de operación de tres posiciones: 
- 1: No hacer nada. Posición al aire. 
- 2: Multiplicar. Entrada asignada a la puerta “0” de P1 
- 3: Dividir. Entrada asignada a la puerta “1” de P1 
 El interruptor con el cual habilitamos la operación está asignado a la puerta “2” de P1. 
 
Si la entrada de “Operación” está activa, entonces se activará la salida “Operación Activa” puerta “6” de 
P1, en este momento se pasará a escrutar las entradas “Multiplicar” y “Dividir” para ver que operación se 
realiza. 
 
- Si la entrada “Multiplicar” está activa, se activará la salida “Multiplicación” puerta 4 de P1 y se 

llamará a una Subrutina que multiplique por 2 el contenido de la dirección 40H. El valor obtenido en 
la subrutina se devolverá en un registro. El programa principal guardará este valor en la dirección 41H. 
El programa continuará revisando las nuevas condiciones. 

- Si la entrada “Dividir” está activa, se activará la salida “División” puerta 5 de P1 y se llamará a una 
Subrutina que divida por 2 el contenido de la dirección 40H. El valor obtenido en la subrutina se 
devolverá en un registro. El programa principal guardará este valor en la dirección 42H. El programa 
continuará revisando las nuevas condiciones. 

 

 
Las entradas son activas por nivel “0” y las salidas por nivel “1”. 
 

2. EJERCICIO 2º : 
 Almacenar los valores 01H, 02H, 10H y 20H en las posiciones de memoria 90H, 91H, 92H y 93H 

respectivamente. Sumar los contenidos de estas posiciones de memoria dejando el resultado en la 
posición 30H y en la FFH. 

 
NOTAS: 
1. Ambos programas comenzarán en la dirección 20H. 
2. Se comentarán ambos ejercicios (programas), no se admitirá un ejercicio con solo instrucciones. 
 
El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos. 
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Ordinaria de JUNIO 2005) 

LABORATORIO 
 
1. EJERCICIO 1º : 
 Disponemos de tres entradas al microcontrolador, estas son E 1,  E 2 y E 3; además disponemos de un 

interruptor “Proceso” con el cual vamos a indicar al microcontrolador que comienza el Proceso. 
 
 El programa está a la espera de que se active el interruptor de “Proceso”, ésta señal está en la puerta “0” 

de P1. Cuando se active este interruptor activaremos la salida 4 de P1, borraremos el contenido de las 
direcciones 20H, 21H y 22H y comenzaremos el Proceso. Una vez activo el Proceso, el programa 
determinará cual es la secuencia de Entradas (E) que se ha activado 

 
 La reglas del Proceso son las siguientes : 

- Cuando se active “E 1”, se activa la salida 5 de P1, se leerá el dato N de la puerta P2, se guardará este 
dato en la dirección 20H, se incrementa en “1” y se almacena el resultado en la dirección 80H. 

- Cuando se activen simultáneamente “E 1 y E 2”, se activa la salida 6 de P1, se leerá el dato N de la 
puerta P2. Se guardará en la dirección 21H, se incrementa en “2”  y se almacena el resultado en la 
dirección 81H. 

- Cuando se activen simultáneamente “E 1, E 2 y E 3”, se activa la salida 7 de P1, se leerá el dato N de 
la puerta P2. Se guardará en la dirección 22H, se incrementa en “3” y se almacena el resultado en la 
dirección 82H. 

- Nuevas pulsaciones se tienen en cuenta cuando se han liberado todos los pulsadores. 
 

La señal “E 1” se leerá de la puerta “1” de P1. 
La señal “E 2” se leerá de la puerta “2” de P1. 
La señal “E 3” se leerá de la puerta “3” de P1. 

 
Las entradas son activas por nivel “0” y las salidas por nivel “1”. 
Las señales de salida permanecen hasta que se liberan ambos pulsadores o bien se desactiva la señal de 
proceso. 
 

2. EJERCICIO 2º : 
 En la dirección 10H y 11H hay dos valores cualesquiera, si el contenido de la dirección 10H es mayor que 

el contenido de la 11H, entonces se decrementará el contenido de la 10H y se llevará el resultado a la 
dirección 90H. Si el contenido es menor entonces se incrementará y el resultado se llevará a la dirección 
91H. 

 
NOTAS: 
1. Ambos programas comenzarán en la dirección 20H. 
2. Se comentarán ambos ejercicios (programas), no se admitirá un ejercicio con solo instrucciones. 
 
El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos. 
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Ordinaria de ENERO 2006) 

LABORATORIO 
 
1. EJERCICIO 1º : 
 Se trata de realizar un programa que efectúe una de tres operaciones (sumar, restar o no operar). El estado 

de un interruptor externo al procesador iniciará las operaciones. Las operaciones se realizarán en sendas 
subrutinas. Los datos a operar son N1 y N2 (enteros sin signo) ambos de cuatro bits, dispuestos sobre la 
puerta P1. 

 
Disponemos de un interruptor “Operar” de dos posiciones, asignado a la puerta “4” de P2: 
- 1: Interruptor abierto: No hacer nada. 
- 2: Interruptor cerrado: Operar. 

 
Si la entrada “Operar” está activa, entonces se activará la salida “Operando” puerta “0” de P2, en este 
momento se pasará a escrutar las entradas de datos “N1” (P1.7 .. P1.4) y “N2” (P1.3 .. P1.0) para ver qué 
operación se realiza, según las siguientes condiciones: 
- Si N1 es mayor que N2, se activará la salida “N1>N2” puerta 1 de P2 y se llamará a una Subrutina 

que reste estos dos valores (N1-N2). El valor obtenido se guardará en la dirección 80H. El programa 
continuará revisando las nuevas condiciones. 

- Si N1 es menor que N2, se activará la salida “N1<N2” puerta 2 de P2  y se llamará a una Subrutina 
que sume estos dos valores (N1+N2). El valor obtenido se guardará en la dirección 81H. El programa 
continuará revisando las nuevas condiciones. 

- Si N1 es igual a N2, se activará la salida “N1=N2” puerta 3 de P2, no realizándose ninguna operación. 
El programa continuará revisando las nuevas condiciones. 

 
Una vez terminada una operación, para volver a realizar nuevas operaciones hay que esperar a que la 
señal “Operar” se desactive. 

 
La entrada “Operar” es activa por nivel “0” y las salidas por nivel “1”. 
Los valores N1 y N2 se salvarán en posiciones de memoria baja o en registros, a voluntad del alumno. 
 

2. EJERCICIO 2º : 
 Almacenar los valores 01H, 02H, 11H y 22H en las posiciones de memoria 80H, 81H, 82H y 83H 

respectivamente. Sumar los contenidos de estas posiciones de memoria dejando el resultado en la 
posición 84H y llevar el resultado a la puerta P1. 

 
NOTAS: 
1. Ambos programas comenzarán en la dirección 20H. 
2. Se comentarán ambos ejercicios (programas), no se admitirá un ejercicio con solo instrucciones. 
3. El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos. 
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ESCUELA UNIVERSITARIA DE INGENIERÍA TÉCNICA INDUSTRIAL 
 

INFORMÁTICA DE GESTIÓN 2º 
 

EXÁMEN DE ESTRUCTURA DE COMPUTADORES II. 
(Convocatoria Ordinaria de JUNIO 2006) 

LABORATORIO 
 
1. EJERCICIO 1º : 
 Se trata de realizar un programa que regule el nivel de agua en un depósito. La altura (H) del nivel de 

agua se dispone sobre la puerta P2 de nuestro microControlador. H (altura) es un valor digital que se lee 
de un conversor directamente. Se Abren o Cierran dos electroválvulas EV1 (puerta 2 de P1) y EV2 
(puerta 3 de P1). La posición de las electroválvulas nos la da los sensores PEV1 (puerta 0 de P1) y PEV2 
(puerta 1 de P1). 

  
La funcionalidad es la siguiente: 
- Si H es mayor que 220 cm., se activará la salida Alarma “Alto”, puerta 5 de P1, y se llamará a una 

Subrutina que Cierre EV1 y Abra EV2. El programa continuará revisando las nuevas condiciones. 
- Si H es menor que 50 cm., se activará la salida Alarma “Bajo”, puerta 6 de P1, y se llamará a una 

Subrutina que Abra EV1 y Cierre EV2. El programa continuará revisando las nuevas condiciones. 
- Si H es mayor que 50 cm. y menor que 220 cm., se activará la salida Nivel “Correcto”, puerta 7 de P1, 

y se llamará a una Subrutina que Abra EV1 y Abra EV2. El programa continuará revisando las 
nuevas condiciones. 

Nota: Antes de realizar la acción de Abrir o Cerrar, se comprobará la posición para determinar si se lleva 
a cabo o no. El programa no termina nunca. 
Para facilitar el ejercicio, vamos a suponer que con la orden de Abrir o Cerrar las electroválvulas, éstas 
Abren y Cierran siempre. 

 
2. EJERCICIO 2º : 

Sumar los contenidos de las direcciones F0H y F1H, dejando el resultado en la posición 20H. Si hay bit 
de Carry, dejarlo en el bit “0” de 21H. 

 
NOTAS: 
1. Ambos programas comenzarán en la dirección 20H. 
2. Se comentarán (partes significativas) ambos ejercicios, no se admitirá un ejercicio con solo instrucciones. 
3. El ejercicio nº 1 se puntuará con 1.5 puntos y el nº 2 con 0.5 puntos. 

P2 
7 
· 
· 
0 

P1 
0 
 

1 
 

2 
 

3 
 

5 
 

6 
 

7 

Alarma  “Alto” 

Alarma  “Bajo” 

Nivel “Correcto” 

Posición EV1 

µC 

Altura (H) Posición EV2 

Abrir/Cerrar EV1

Abrir/Cerrar EV2 

M 

EV2 

M 

EV1 

8 bits 

H 

Presión 
Columna 
de Agua 

Hmax 250 

Conversor de Presión a 
Altura (valor digital)

P/H


